
Wireless Management Toolkit 
User Manual 

XYR 5000 Line 
34-XY-25-06 

Rev. 2 
06/04 





Honeywell Industrial Wireless                     Wireless Management Toolkit  

   Rev. 2 User Manual                     I   
06/04 

User Manual 

Wireless Management Toolkit 
Model WMT 
Versions 1.57 or later 

Honeywell Inc. 

Industrial Measurement and Control 

2500 West Union Hills Drive 

Phoenix, AZ 85027 

Copyright 2004 by Honeywell International Inc. 
Rev. 2- 06/28/2004 

 While this information is presented in good faith and believed to be accurate, Honeywell disclaims the implied warranties of merchantability and 
fitness for a particular purpose and makes no express warranties except as may be stated in its written agreement with and for its customers. 

In no event is Honeywell liable to anyone for any indirect, special or consequential damages. The information and specifications in this document 
are subject to change without notice. 

Honeywell® and TotalPlant® are U.S. registered trademarks Of Honeywell International Inc. 
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Important Information to the User ! 

• Changes or modifications not expressly approved by the manufacturer may void 
the user’s authority to operate the equipment. 

 
• This computer program is protected by copyright law and international treaties. 

Unauthorized reproduction or distribution of this program, or any portion of it, 
may result in severe civil and criminal penalties, and will be prosecuted to the 
maximum extent possible under law. 

 
• If the Wireless Management Toolkit (Honeywell Server) software is shutdown, 

the RS-485 network MUST be physically disconnected from the PC as the 
serial port is no longer being controlled by the software and may disrupt commu-
nications between the Base Radio(s) and Analog/Digital Output Module(s). 

! 
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About This Document 

Revision Notes 

The following list provides notes concerning all revisions of this document. 
 
  

 
 
  

 Contacts 

World Wide Web 

The following lists Honeywell’s World Wide Web sites that will be of interest to our industrial automation and control customers. 
 

  
 

 Telephone 

Contact us by telephone at the numbers listed below. 
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Global Technical Support Center 

1-800-343-0228 Sales  
1-800-525-7439 Service 

1-800-423-9883 

Asia Pacific Honeywell Asia Pacific Inc. 
Hong Kong 

(852) 8298298 

Europe Honeywell PACE 
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Section 1: Introduction 

1.1: USING THIS MANUAL This manual is designed to assist in installing, operating, and maintaining 
Honeywell Wireless Management Toolkit software. The manual is broken 
into sections as follows: 
 
Section 2: In a Hurry? 
This section summarizes what must be done in order to get the software 
installed, configured and in operation quickly. However, it does not pro-
vide detailed or how-to information to perform the tasks outlined. 
 
Section 3: Installation 
This section explains how to correctly install, set up communications and 
run the software.  
 
Section 4: Running the Honeywell Server 
In order for the Wireless Management Toolkit to constantly record data 
from the Field Units and make this information available to the users, a 
program called the Honeywell Server needs to be running on the computer 
the Base Radio Network is plugged into at all times. This computer will 
also act as a server to all users who wish to log into Wireless Management 
Toolkit and use the Client software. 
 
Section 5: Which Mode Should I Run? 
The Wireless Management Toolkit software can be run in one of two 
modes: Configuration Mode or Management Mode. This section will aid 
the user in choosing the mode which best fits his or her needs. 
 
Section 6: Running the Client Software 
Once the user has set up and run the Honeywell Server the Client software 
can be run from the (Local) computer on which the Honeywell Server is 
running (available in both Management and Configuration Mode), or the 
Client software can be run from a remote computer over a TCP/IP 
(Network) connection (available only in Management Mode). 
 
Section 7: Formatting and Maintaining the Database 
If the user has selected to use the Wireless Management Toolkit software 
in Management Mode the database will store all Field Unit and Output 
Device configurations, as well as every transmitted sample of every Field 
Unit, within the Honeywell Server. Because the number of Field Units and 
frequency of data transmission varies with each Wireless Instruments in-
stallation, the rate at which this database grows also varies. To accommo-
date the different needs of different users, there are a series of database 
options the user should set.  
 
Section 8: Understanding the User Interface 
The Wireless Management Toolkit has multiple “Views” in which the user 
may monitor and configure devices, as well as, export data for use in other 
applications. This section will familiarize the user with each of these 
views. 
 
Section 9: Device Monitoring, Configuration and Data Exporting 
Once the user is familiar with the different views, this section explains 
how to monitor and configure devices. Also covered in this section is the 
ability of Wireless Management Toolkit to export data in various formats 
for use with other applications. 
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1.2: ABOUT THE SOFTWARE The Honeywell Wireless Management Toolkit software is a real-time net-
work configuration and monitoring software package. The Wireless Man-
agement Toolkit allows you to quickly and accurately perform data acqui-
sition at a fraction of the cost of a wired system with a PLC or DCS. In 
addition, the Wireless Management Toolkit software allows for the remote 
configuration of Field Units and Output Devices that would normally be 
done at the device, saving time and money. 
 
Wireless Management Toolkit also has exporting for analysis capabilities , 
which give you bigger and faster returns on your wireless instrumentation 
investments. This software can be used for long term monitoring in remote 
locations, for short-term data gathering on process conditions, or to 
quickly test the economic viability of a new installation. 
 
The purpose of this Guide is to help you install and maintain your Honey-
well Wireless Management Toolkit Software.  

1.3: UNPACKING Remove the Packing List and check off the actual equipment received. If 
you have any questions on your shipment, please call your Honeywell 
Representative. Upon receipt of shipment, inspect the container for any 
signs of damage in transit. Especially take note of any evidence of rough 
handling. Report any apparent damage immediately to the shipping agent.   
 
Please note that sometimes units are assembled with accessories when 
shipped. Inspect the shipment carefully if you think that something is 
missing. This is rare, as we take considerable care to pack units for ship-
ment, but it does sometimes happen. Please give us a call and we may be 
able to resolve this matter quickly over the phone.  

NOTE 
Please note that the carrier will not honor any claims for damage unless 
all shipping materials are saved for their examination. If damage is found 
during examining and removal of the contents, save the packing material 
and the carton. 

1.4: SYSTEM  
 REQUIRMENTS 

Operating System Requirements: 
Windows® 2000or Windows® XP 
 
Hardware Requirements: 
Processor:  Intel/AMD 300 MHz 
Memory:  256 MB RAM or Greater 
Hard Disk Space: 150 MB for configuration,  
  recommend 500 MB additional space if data  
  collection enabled 
Dedicated serial COM port 
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This section summarizes what must be done in order to get the software 
installed, configured and in operation quickly. It does not provide detailed 
or how-to information to perform the tasks outlined. 
 

Section 2: In a Hurry?  

1. Insert Wireless Management Toolkit CD in CD-ROM drive of the 
computer into which the Base Radio RS-485 Network will be plugged 
(this is called the Host computer). 

2. Follow the installation instructions and install the software. 
3. Run the Honeywell Wireless  by clicking on the desktop icon. 
4. When prompted (when run for the first time only) select Configura-

tion Mode or Management Mode. 
5. Connect to the Honeywell Server, which is automatically launched 

via the following settings in the connection view: 
• Local Computer 
• 127.0.0.1 
• Admin 
• Password 

6. Wait for software to discover all the devices on the network. 
7. Each yellow device is an unconfigured device. Configure these de-

vices with appropriate settings and tag names. Upon configuration 
these devices will turn green. 

 
The following only applies if you answered Management Mode to number 
four in the above list: 
1. Set up user accounts and access levels via the Accounts  view. 
2. Set up database management options via View? Server Options. 
3. Exit the software and verify that the blue and red RF icon remains 

running in the system tray (lower right corner). This must remain run-
ning at all times if want to log data into the database. It also must re-
main running if you to log in to the network via a remote computer. 

4. You must find the IP Address of the Host computer. Follow the in-
structions below: 

• Click on the Start button 
• Select Run 
• Enter “cmd” for a Windows® 2000 or XP computer 
• Enter “ipconfig” into the command line and press return 
• Record the IP Address, e.g. 192.168.1.66 

 
The following applies if you are trying to log into Wireless Management 
Toolkit via a remote computer (Note: you must have selected Manage-
ment Mode in task four above. If you did not select this mode go back to 
the Host computer, run the software, and under View? Client Options  
select Management Tool). 
1. Insert Wireless Management Toolkit CD in CD-ROM drive of the 

computer (this is called the Client computer). 
2. Follow the installation instructions and install the software. 
3. Run the Honeywell Wireless  by clicking on the desktop icon. 
4. Connect to the Honeywell Server running on the Host computer via 

the following settings in the connection view: 
• TCP/IP 
• Enter IP Address of Host computer, e.g. 192.168.1.66 
• Enter a User and Password of an account you set up 

NOTE 
If your Base Radio is not plugged into COM Port 
1 of the Host computer, then the user must right-
click on the RF icon in the system tray (lower 
right corner) and select Options. This will allow 
the user to change the COM Port to the appropri-
ate port number. 

NOTE 
If the Honeywell Server is not running on the Host 
computer, you will not be able to log in.  
 
Also, a single user account cannot be logged into 
the Honeywell Server on more than one computer 
at a time. 

NOTE 
The Honeywell Server is run automatically (if it is 
not already running) when the software is 
launched and a user connects.  
 
If the software is run in Management Mode the 
Honeywell Server will not be shut down upon 
exiting the program as it must remain running to 
collect data and allow users to login remotely. 
 
To shut down the Honeywell Server, right-click 
on the Honeywell icon in the system tray (lower 
right corner) and select Exit.  
 
If the Honeywell Server is shutdown, the RS-485 
network MUST be physically disconnected from 
the PC as the serial port is no longer being con-
trolled by the software and may disrupt communi-
cations between the Base Radio(s) and Analog/
Digital Output Module(s). 
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Section 3: Installation 

To begin installation place the Wireless Management Toolkit CD in the 
computer’s CD-ROM drive. 
 
The InstallShield Wizard should be displayed on the monitor automati-
cally as seen in Figure 3.1. 
 
Once the InstallShield Wizard is up and running, Click the Next button.  
 
  
 
 

Figure 3.1: InstallShield Wizard  

Figure 3.2: Software User Agreement Screen  

Figure 3.3: User and Organization Screen  

Figure 3.4: Installation Path Screen  

The following screen, shown in Figure 3.2, requires you to accept the li-
cense agreement. 
 
Select I accept the terms in the license agreement, which indicates you 
have read and agree to the contents in the End User Software License 
Agreement. 
 
Click Next to move to the screen shown in Figure 3.3. 
 
  
  

Enter a User Name and Organization, and then click Next. 
 
Now, click on Install. The InstallShield Wizard will now install the Hon-
eywell software to the computer. Note: the install process may take a few 
minutes. 
  
 
 

After the installation is complete the screen in Figure 3.4 will be dis-
played. 
 
Click on Finish to exit the InstallShield Wizard and complete the installa-
tion. 
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Section 4: Running the Honeywell Server 

In order for the Wireless Management Toolkit to constantly record data 
from the Field Units and make this information available to the users, a 
program called Honeywell Server needs to be running at all times on the 
computer the into which Base Radio is plugged (the Host computer). This 
computer will act as a Host to all users who log in via remote computers. 
 
If you have not done so already, install the Wireless Management Toolkit 
software on the computer. Then follow these instructions to run the Hon-
eywell Server: 

• Click on the Start button 
• Highlight Programs  
• Highlight Honeywell WMT 
• Select Honeywell Server 

 
Once you have done this, you should see a Honeywell Server Icon in the 
lower right hand corner of Windows like the one shown in Figure 4.1. 
Because the Honeywell Server is intended to run in the background and 
constantly monitor and record data from the Base Radio through the COM 
Port, it has a limited user interface that can be seen by right-clicking the 
Honeywell Server Icon. To view the data being recorded the user can 
login using the Client program (See Section 6 for more details).  
 
The Base Radio should be plugged into an available COM Port on the 
computer at this time. Right-clicking on the Honeywell Sever Icon will 
allow the user to select the appropriate COM Port. The default is COM 
Port 1.  

In order for the Wireless Management Toolkit to receive data from the 
Base Radio, the Honeywell Server must be running on the Host computer. 
If this is not the case no data will be recorded, and you will not be able to 
connect and run any Clients from remote computers.  
  
If you wish to shut the Honeywell Server application down, right-click on 
the Honeywell Icon and select Exit. Note that you must restart the Honey-
well Server on the Host computer in order to receive data and run the Cli-
ent software. 
  
In order to allow the Client software to find the Honeywell Server, you 
must also specify where the Honeywell Server is located. If the Client and 
Host are the same computer the connection type is Local Computer. If the 
Client is a remote computer the connection type is TCP/IP and the IP Ad-
dress of the Host computer must be specified.  
 
To find the IP Address of the Host computer follow these instructions: 

• Click on the Start button 
• Select Run 
• Enter “cmd” for a Windows® 2000 or XP computer 
• Enter “ipconfig” into the command line and press return 
• Record the IP Address, e.g. 192.168.1.66 

Useful Definitions  
Honeywell Server– a program that runs 
on the Host computer which stores all 
incoming data and provides this data to 
all the Clients logged in.  
 
Host computer– the PC or server into 
which the Base Radio is plugged, and 
on which the Honeywell Server is being 
run.  
 
Client computer– any computer that is 
running the Wireless Management Tool-
kit program. The Client computer can 
be the same computer as the Host com-
puter. 
 
Remote computer– a computer that is 
connected to the Host computer via a 
TCP/IP network connection. 
 
Local Computer– a connection type 
that is used when the Host and Client 
are the same computer. This means that 
the Client can find the Honeywell 
Server “locally”, (i.e., the same com-
puter). 
 
TCP/IP– a connection type that is used 
when the Client computer must use a 
network connection (e.g. an office intra-
net) to connect to the Honeywell Server 
running on the Host computer. This 

Figure 4.1: Honeywell Server Icon  

NOTE 
The Honeywell Server program must remain 
running to collect data and allow users to login 
remotely. 
 
If the Honeywell Server is not running on the Host 
computer, users will not be able to log in.  
 
Also, a single user account cannot be logged into 
the Honeywell Server on more than one computer 
at a time. 

NOTE 
If you experience mouse issues, unplug and plug in the Base Radio. Also 
do not leave the Base Radio plugged in while rebooting the computer as 
this will cause the PC to recognize the Base Radio as a mouse an move 
the pointer erratically. Instead wait until you are ready to run the software. 
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Section 5: Which Mode Should I Run?  

The Configuration Tool setting should be used when the user wishes to  
plug into existing networks, (or move from network to network) in order 
to configure units without retaining the gathered data that is accumulated 
while the Honeywell Server is running. 
 
In Configuration Mode (See appropriate sections for clarification): 

• Data is stored in database and DELETED when Honeywell 
Server or Client software is shut down         (Sec. 7) 

• Users CANNOT log in from remote computers      (Sec. 6) 
• User accounts CANNOT be created        (Sec. 8) 
• User can connect via Local Computer only             (Sec. 3) 
• User does not need to manage database size            (Sec. 7) 
• Server is shut down when Client is closed               (Sec. 4) 

 
Another important distinction is that, unlike the Management Mode, the 
Configuration Mode does not save all the configuration data of the net-
work. In this mode the software simply gathers as much configuration 
information from the network as it can. When configuration changes are 
made to any of the devices via the software, these changes are 
downloaded to the devices and preserved.  

5.1: Management Mode 

5.2: Configuration Mode 

The Management Tool setting should be used when the user wishes to 
only monitor and configure a single Wireless Instrumentation network that 
will not be disconnected and moved from network to network. 
 
In Management Mode (See appropriate sections for clarification): 

• Data is stored in database and NOT deleted when Honeywell 
Server is shut down                                                 (Sec. 7) 

• Multiple users can log in from remote computers   (Sec. 6) 
• User accounts and security levels can be created    (Sec. 8) 
• User can connect via Local Computer and TCP/IP (Sec. 3) 
• Requires user to manage database size and settings(Sec. 7) 
• Server remains running when Client is closed         (Sec. 4) 
 

Another important  distinction is that unlike Configuration Mode, the 
Management Mode saves all the configuration data for the Output Mod-
ules and reconfigures these devices every time the Honeywell Server is 
launched. Thus if a different wireless network is plugged into the Host 
computer the old configuration data will be uploaded to the different de-
vices that share that same ID’s as the old devices, which may cause out-
puts to be not what is expected.  
 
This issue can be mitigated by using separate Host computers or by run-
ning in Configuration Tool Mode. 

The Wireless Management Toolkit software can be run in one of two 
modes: Configuration Tool Mode or Management Tool Mode. This sec-
tion will aid the user in choosing the mode which best fits his or her  
needs. 
 
These modes are called Client (referring to the software) Options. When 
Wireless Management Toolkit is run for the first time the user is asked to 
make this decision. However, this setting may changed at any time by 
selecting Client Options from the View menu at the top of the program 
window.  

NOTE 
The Mode setting can be changed at anytime by 
selecting Client Options from the View menu at 
the top of the program window. 

NOTE 
Once Wireless Management Toolkit is connected 
to a wireless network and the Wireless Manage-
ment Toolkit is in Management Mode, certain 
Field Unit menus will no longer be locally acces-
sible via the next and enter buttons. This is done to 
prevent Field Unit settings from being changed 
without the Administrator’s knowledge.  
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Section 6: Running the Client Software 

NOTE 
If you have selected to run in Configuration Tool 
Mode then the connection type is limited to Local 
Computer. (See Section 5 for more details.) 

The Wireless Management Toolkit client software is the application that is 
used to connect to the Honeywell Server in order to configure and monitor 
devices. This software can be run on the Honeywell Server Host computer 
or it can be run on a remote computer and connected to the Honeywell 
Server via a TCP/IP connection. Both cases shall be covered in this sec-
tion of the manual. 
 
Once you have installed the software, the Wireless Management Toolkit 
Client icon should appear on the desktop. This icon is indicated by the 
arrow in Figure 6.1. 
 
Double-click on this icon to start the program, or the Wireless Manage-
ment Toolkit can also be accessed by following these instructions: 

• Click on the Start button. 
• Highlight Programs. 
• Highlight Honeywell WMT. 
• Select Honeywell Wireless Management Toolkit  

 
Once the Client software has been started the Connection View will be 
displayed. This view is shown in Figure 6.2. 
 
 

6.2: TCP/IP Connection 

The Wireless Management Toolkit has two Client connection options. The 
first is a Local Computer Mode. This mode should be used when running 
the Client on the same computer on which the Honeywell Server will be 
run. (See Section 5 for more details) 
 
Since the Client can find the Honeywell Server on the same computer 
from which it is being run, it is said that the Honeywell Server is being run 
“locally” or on the same computer. This type of connection does not re-
quire an IP Address to be specified. A Local connection would be per-
formed as follows: 

• Connection: Local Computer 
• Server: no option 
• User: Admin 
• Password: password 

Figure 6.1: Desktop Icon  

Figure 6.2: The Connection View  

6.1: Local Computer 
 Connection 

The second Client connection option is the TCP/IP Mode. This mode 
should be used when the Honeywell Server is being run on different com-
puter and the user wishes to log in via a network connect on his/her com-
puter.  
 
Since the Client must find the Honeywell Server via a network, the Client 
must be given an IP Address where the server can be found. This type of 
connection is called a TCP/IP connection. A TCP/IP connection is per-
formed as follows: 

• Connection: TCP/IP 
• Server: 192.168.1.88 (for example) 
• User: Admin or any created user account 
• Password: password 

If you are unfamiliar on how to obtain the Host computers IP Address, see 
Section 5. 

NOTE 
If security is an issue, the Admin (or manager of 
the Wireless Network) should log in under the 
Admin account and setup new accounts for all 
users. The Admin account should then be deleted. 
 
Also, note that Wireless Management Toolkit 
security, much like many programs, is only as 
good as the Host computers security. If security is 
an extreme issue then the Host computer should 
be accessible to the Admin only. 
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Every transmitted sample of every Field Unit is logged into a database 
within the Wireless Management Toolkit software. Because the number of 
Field Units and frequency of data transmission varies with each Wireless 
Instruments installation, the rate at which this database grows also varies. 
To accommodate the different needs of different users, there is a series of 
database options the user should set.  
 
These options can be found by clicking the View menu in the upper left -
hand title bar and then selecting Server Options . When you have done so 
you should see a screen like the one shown in Figure 7.1. 
 
The settings shown in Figure 7.1 are the default settings of the data stor-
age options. The Save Data check-box allows the user to enable or disable 
the saving of incoming Field Unit data in the database. 
 
If you do not want to export data, generate reports, save device configura-
tion data, or see graphs of past Field Unit values, uncheck the save data 
box. Doing so will still allow the user to monitor alarms and real-time 
streaming data. No Field Unit history will be kept. 
 
If you want to see past Field Unit data graphs or export data, check the 
box to save the incoming data. Note that this will use a varying amount of 
hard drive space. 
 
If you have chosen to save data then you should also set the high and low 
resolution data settings according to your demands. A description of the 
function of each setting is located to the right of the settings.  
 

• High resolution data consists of a data point for every 
transmitted value by every Field Unit. 

• Low resolution data consists of one minute’s worth of data 
points averaged to one data point for each Field Unit. 

 
If you wish to preserve the database beyond the 90-day low resolution 
data limit, you must make a copy of the database file. To do so, open 
Windows Explorer ?  (C: or your hard drive) ?  Program Files 
? HoneywellWMT\Database. You may copy and paste the database 
folder in any folder you choose. It is suggested you rename the saved data-
base with the date range, (e.g., Jun-Aug 2003).  
 
If you run out of hard drive space due to the size of the database you may 
have to reduce the length of time that the low resolution data is retained. 
Doing so will reduce the size of the database. 

NOTE 
If the user has opted to run Wireless Management 
Toolkit in Configuration Tool Mode, the database 
will only store data while the Client software and 
Honeywell Server are running. Upon closing  
these programs, all saved configuration and sam-
ple data will be deleted. 

Figure 7.1: Database Storage Options View 

Section 7: Formatting and Maintaining the Database 
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Once you have connected the software to the Honeywell Server (See Sec-
tions 4 and 6), you will be able to select the Connection, Field Units, Base 
& Output Devices, Data Maps, Tasks, or Accounts views by clicking on 
the respective icon in the Views pane located on the left hand side of the 
Client program. 
 
The following sections will step through each of these views and describe 
their functionality and features. The section outline is as follows: 

 
8.1: The Field Unit View 

8.1.1: The Overall Field Units’ Conditions 
8.1.2: The Selected Field Unit Condition 
8.1.3: The Field Units Pane 
8.1.4: The Field Unit Group Tree 

8.2: The Base & Output Devices View 
8.3: The Data Maps View 
8.4: The Tasks View 
8.2: The Accounts View 

8.1: The Field Unit View 

The Events and Chat Log 
At the bottom of every view an Events or Chat 
Log is displayed. The view of either of these is 
toggled by clicking either of the labeled tabs in the 
lower left hand corner of the Client software. 
 
The Events Log records the last 50 changes that 
were made to the network (e.g. addition of new 
Field Unit, changing of Field Unit status). Each of 
these events is logged with a description, as well 
as a time and date stamp. 
 
The Chat Log allows the user to chat with all users 
on the network and see which users are currently 
logged into the Honeywell Server via the Client 
program. The chat log works by posting a message 
to the user and allowing them to reply, much like 
an instant messenger service.  

Section 8: Understanding the User Interface 

The view you will see upon connection is the Field Unit View. This view 
shows the Field Unit information, and allows you to configure and view 
individual Field Unit data. This view can be accessed at any time by click-
ing on the Field Units icon in the Views pane. The Field Unit View is 
shown in Figure 8.1. 

 
 
Each of the four numbered areas in Figure 8.1 above, will be explained in 
following sections in respective order. 

8.1.1: The Overall Field Units’ 
Conditions 

The Overall Field Units Conditions (labeled as #1 in Figure 8.1) box refers 
to all Field Units that are on the network. This box tells the user the total 
number of Field Units there are, how many Field Units are in an alarm 
condition (red), and how many Field Units are in a warning condition 
(yellow or orange). 

Figure 8.1: Field Unit View 

NOTE 
The installation and configuration of the individ-
ual Field Units via Wireless Management Toolkit 
is covered in the respective Field Unit User Manu-
als. Please see these manuals for more specific 
details regarding these devices.  
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The Selected Field Unit Conditions box (labeled #2 in Figure 8.1) is dif-
ferent from the Overall Field Unit Conditions box, in that the Selected 
Field Unit shows only the condition or the Field Unit that is selected in the 
Field Units Pane. This box shows the Field Unit type and the current con-
dition: 
 

• Green - All systems are configured and OK. No Alarms  
• Yellow   - The Field Unit is un-configured  
• Orange  - There is a system warning with the Field Unit  
• Red - An Alarm is being exceeded 

8.1.2: The Selected Field Unit  
 Condition 

8.1.3: The Field Units Pane The Field Units Pane (labeled #3 in Figure 8.1) shows all the Field Units 
in the selected group from the Field Units Group Tree (#4). Each Field 
Unit in this pane has a color that indicates its current condition (see #2 for 
color description), the monitored equipment, the ID (See Note), device 
type, status of the Field Unit, and the current primary and secondary val-
ues that the Field Unit is reading. (For more information on how to config-
ure and monitor individual Field Units see Section 9). 

NOTE 
Field Units are often referenced throughout the 
software by two numbers, such as 1-1 in Figure 
8.1. The first number refers to the Base Radio ID 
and the second number refers to the Field Unit RF 
ID. 

8.1.4: The Field Units Group Tree The Field Unit Group Tree (labeled #4 in Figure 8.1) allows the user to 
select and group which Field Units are displayed in the Field Units Pane 
(#3).  
 

• The All Field Units view is the default view and will display 
a scrollable list of every Field Unit that has been discovered 
on the network.  

 
• The Alarming Field Units view will display only Field 

Units that are in an alarm condition (discussed in the Field 
Unit Configuring and Monitoring section).  

 
• The Unconfigured Field Units  view displays Field Units 

which have been discovered on the network, but have not 
been renamed or configured.  

 
• The Field Unit Groups view allows the user to assign Field 

Units to individual groups, and then view the Field Units by 
those groups. Groups are added by right clicking on the Field 
Unit Groups folder and selecting Add Child Group. Deleting 
and Renaming of groups is done in the same fashion. To add 
Field Units to a group, click the desired Field Unit and drag 
it and drop it to the appropriate group folder. 

 
• The Base Radios view displays the Field Units that are asso-

ciated with selected Base Radio.  
 
• The Field Unit Types view displays each set of Field Units 

on the network by type, e.g. Acoustic Field Unit . 
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The next view is the Base & Output Devices View. This view shows the 
Base Radio and optional Analog/Digital Output Devices (see the Ana-
log/Digital Output Module User Manual for more information on installa-
tion on configuring this device).  
 
The Base & Output Devices view allows you to rename and view data 
about each of your Base Radios as well as any optional Analog/Digital 
Output Modules you have installed on the RS-485 network.  
 
This view can be accessed at any time by clicking on the Base & Output 
Devices Icon in the Views pane. The Field Unit View is shown in Figure 
8.2. 

 
  

 
The RS-485 address and number of Field Units communicating with each 
Base Radio are listed under the Base Radio pane. The RS-485 address and 
output device type are listed for each Analog/Digital Output Module under 
the Output Device pane. 

8.2: The Base & Output Devices 
 View 

Figure 8.2: The Base & Output Devices View 

NOTE 
If you have added a new device such as Field Unit or Analog/Digital Out-
put Module to an existing wireless network the device may not show up 
automatically in the Client software. To force the program to search for 
new devices click Discover Devices  under the File menu. 

NOTE 
The installation and configuration of the Analog/
Digital Output Modules via Wireless Management 
Toolkit is covered in the Analog/Digital Output 
Module User Manual. Please see this manual for 
more specific details regarding this device. 

The Events and Chat Log 
At the bottom of every view an Events or Chat 
Log is displayed. The view of either of these is 
toggled by clicking either of the labeled tabs in the 
lower left hand corner of the Client software. 
 
The Events Log records the last 50 changes that 
were made to the network (e.g. addition of new 
Field Unit, changing of Field Unit status). Each of 
these events is logged with a description, as well 
as a time and date stamp. 
 
The Chat Log allows the user to chat with all users 
on the network and see which users are currently 
logged into the Honeywell Server via the Client 
program. The chat log works by posting a message 
to the user and allowing them to reply, much like 
an instant messenger service.  
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The next view is the Data Maps View. This view allows the user to “map” 
outputs of Field Units to a one of four 4-20mA output loops on a single 
Analog Output Module (WI-4AO) or Analog/Digital Output Module (WI-
4AO-8SW).  
 
If you have purchased a Analog/Digital Output Module you should refer 
to the Analog/Digital Output Module User Manual for more information 
on setting up the device and using the Wireless Management Toolkit to 
configure and map Field Unit outputs. The Data Maps View is shown in 
Figure 8.3. 

8.3: The Data Maps View 

NOTE 
If you have added a new device such as Field Unit or Analog/Digital Out-
put Module to an existing wireless network the device may not show up 
automatically in the Client software. To force the program to search for 
new devices click Discover Devices  under the File menu. 

NOTE 
The installation and configuration of the Analog/
Digital Output Modules via Wireless Management 
Toolkit is covered in the Analog/Digital Output 
Module User Manual. Please see this manual for 
more specific details regarding this device. 

8.3: The Tasks View 

Figure 8.3: The Data Maps View 

The next view is the Tasks View. The Tasks view shows the scheduled 
tasks that need to take place, such as configuration information to be up-
loaded to the Field Units. This view can be accessed at any time by click-
ing on the Tasks icon in the Views Pane.  
 
The importance of the Tasks view is to let the user know when the con-
figuration changes made to the Field Unit have been successfully 
downloaded to the Field Unit. Thus, the user cannot expect to see the con-
figuration changes at the unit until the task is completed. 
 
 

The Events and Chat Log 
At the bottom of every view an Events or Chat 
Log is displayed. The view of either of these is 
toggled by clicking either of the labeled tabs in the 
lower left hand corner of the Client software. 
 
The Events Log records the last 50 changes that 
were made to the network (e.g. addition of new 
Field Unit, changing of Field Unit status). Each of 
these events is logged with a description, as well 
as a time and date stamp. 
 
The Chat Log allows the user to chat with all users 
on the network and see which users are currently 
logged into the Honeywell Server via the Client 
program. The chat log works by posting a message 
to the user and allowing them to reply, much like 
an instant messenger service.  



Honeywell Industrial Wireless                     Wireless Management Toolkit  

   Rev. 2 User Manual                     13   
06/04 

The next view is the Accounts View. This view allows management of all 
the user accounts. This view can be accessed at any time by clicking on 
the Accounts Icon in the Views Pane. However, only those with Adminis-
trative Access can make changes in this view. The Accounts View is 
shown in Figure 8.4: 

 
 
This view allows the addition, deletion, and editing of user accounts to the 
software. Clicking Add allows the user to add a new user account. When 
adding a new account a name, password, and level of access must be 
given. 
 
There are three levels of access that can be granted to a user:  
 

• Administrative  – able to make changes to anything. 
 
• Read/Write  – able to view data and change Field Units 

and Base Radio outputs and thresholds. 
 
• Read Only  – able only to view the collected Field Unit 

data, and the view the current configurations. Not allowed to 
make changes.  

 
User accounts can be deleted by selecting the user account in the left -hand 
column and clicking the Remove button. User access levels and pass-
words can also be changed by selecting the user account in the left hand 
column and clicking the Update button. 

8.4: The Accounts View 

Figure 8.4: The Accounts View 

NOTE 
If security is an issue, the Admin (or manager of 
the Wireless Network) should log in under the 
Admin account and setup new accounts for all 
users. The Admin account should then be deleted. 
 
Also, note that Wireless Management Toolkit 
security, much like many programs, is only as 
good as the Host computers security. If security is 
an extreme issue then the Host computer should 
be accessible to the Admin only. 

The Events and Chat Log 
At the bottom of every view an Events or Chat 
Log is displayed. The view of either of these is 
toggled by clicking either of the labeled tabs in the 
lower left hand corner of the Client software. 
 
The Events Log records the last 50 changes that 
were made to the network (e.g. addition of new 
Field Unit, changing of Field Unit status). Each of 
these events is logged with a description, as well 
as a time and date stamp. 
 
The Chat Log allows the user to chat with all users 
on the network and see which users are currently 
logged into the Honeywell Server via the Client 
program. The chat log works by posting a message 
to the user and allowing them to reply, much like 
an instant messenger service.  
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Section 9: Device Monitoring, Configuration and Data Exporting 

9.1: Monitoring a Field 
Unit 

Each device has its own monitoring, configuration and data exporting ca-
pability within the Wireless Management Toolkit software. The purpose 
of the this section is to give the user an overview of how to use these capa-
bilities. 
 
The following sections will step through each of these capabilities and 
describe their functionality and features. The section outline is as follows: 

 
9.1: Monitoring a Field Unit 

9.1.1: Field Unit Data Graphs 
9.1.2: Software Alarm Thresholds 
9.1.3: Field Unit State 
9.1.4: Field Unit Primary & Secondary Values 

9.2: Configuring a Field Unit 
9.3: Exporting Field Unit Data 

Each Field Unit has its own monitoring capabilities, which can be ac-
cessed through the Field Unit view. See Section 8.1 for more details on 
what the Field Unit view is, and where it is located. 
 
When in the Field Unit view, double-clicking (or right-clicking and select-
ing View Field Unit Data) on a particular Field Unit’s icon will bring up 
that Field Unit’s Status Window as shown below in Figure 9.1. 

 
The figure above has been numbered from one to four. Each of the follow-
ing subsections will cover these areas of the Field Unit Status view. 
 

Figure 9.1: Field Unit Status View 
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The Field Unit data graphs (labeled #1 in Figure 9.1) show the current and 
all past data that is available in the Field Unit database. The upper graph is 
the Primary process variable (shown as ultrasound in Figure 9.1), and the 
lower graph is the Secondary process variable (shown as temperature in 
Figure 9.1). All process value points are shown in blue if they are within a 
user selected alarm threshold (indicated by a red line). Any data points 
exceeding an alarm threshold appear in red. These alarms can be set in the 
Field Unit Configuration menus under the Alarms  tab.  
 
The Y-axis resolution of the data graphs may be changed in the Field Unit 
Configuration menus under the Range tab. 
 
The data graphs can be panned and zoomed via the control buttons located 
below the graphs. The graphs can also be specified to show a user select-
able data range by using the Specify Range button.  
 
 If at any time you would like to see the most current data simply click the 
Show Current Data button. (NOTE: If the save data option for the data-
base is disabled the graphs will not show any data. Any missing data on 
the graphs will appear as a gray area.) 

9.1.1: Field Unit Data Graphs 

NOTE 
If the save data option for the database is disabled 
the graphs will not show any data. (See Section 7 
for more details on database management) 
 
Any missing data on the graphs will appear as a 
gray area. If the user has selected to run the soft-
ware in Configuration Mode, only data gathered 
during the current run of the software will be 
displayed, as all database data is deleted when the 
software is closed in this mode. (See Section 5 for 
more details). 

9.1.2: Software Alarm Thresholds The Alarm Thresholds (labeled #2 in Figure 9.1) refer to alarm set points 
that have been set in the Wireless Management Toolkit software Field 
Unit Configuration menu to warn the user of important changes the Pri-
mary and Secondary process values. There are 4 alarm thresholds avail-
able for a single process variable unit, and there are 2 alarm thresholds 
available for each process in a dual process variable unit. The alarm 
thresholds are set in the Field Unit Configuration menu under the Alarms 
tab. 

NOTE 
The software alarms exist only within the Client 
software. These alarm thresholds are NOT 
downloaded into any devices, thus these alarms 
are not displayed on the Field Unit LCD’s. 
 
The purpose of these alarms is to notify a user 
looking at the Client software when a possible 
alarm condition exists. 

9.1.3: Field Unit State The Field Unit State box (labeled #3 in Figure 9.1) gives the user the time 
of the last update received from the Field Unit. All other information con-
tained within the State box is specific to the time of the last update time.  
 
The green “OK” message will change to a red exclamation point if the 
respective status reading is in concern or if either of the process values is 
above an alarm threshold. 

9.1.4: Field Unit Primary &  
 Secondary Values 

The current Field Unit primary and secondary values (labeled #4 in Figure 
9.1) are shown via graph levels in blue. If a process variable were exceed-
ing a user set alarm threshold the graph level would appear in red.  
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The Wireless Management Toolkit allows for the configuring of Field 
Unit settings that would normally be done using the next and enter buttons 
on the individual Field Unit. These changes are done via the configuration 
menu.  
 
The configuration menus are displayed by clicking on the Configure but-
ton in the Field Unit’s Status View (See Figure 9.1) or by right clicking on 
the Field Unit icon within the Field Unit View and selecting Configure. 
Doing so will bring up the Configure Menu. 
 
Because each Field Unit has different configuration options available, the 
directions on how to configure a particular Field Unit is located within the 
respective Field Unit’s User Manual. Please see the individual Field Unit 
User Manuals for more details on how to configure these devices using the 
Wireless Management Toolkit software. 

9.2: Configuring a Field Unit 

NOTE 
Once Wireless Management Toolkit is connected 
to a wireless network and the Wireless Manage-
ment Toolkit is in Management Mode, certain 
Field Unit menus will no longer be locally acces-
sible via the next and enter buttons. This is done to 
prevent Field Unit settings from being changed 
without the Administrator’s knowledge. (See 
Section 5 for more details on the Management 
Mode setting). 

9.3: Exporting Field Unit Data The export function allows the user to export Field Unit data from the 
database, in comma separated value (.CSV) or text (.TXT) formats, to a 
separate file for use with different data analysis tools. 
 
To export data for a Field Unit, click on the “Exports” button in the Field 
Unit’s Status View (See Figure 9.1) Doing so will bring up the export 
wizard as shown in Figure 9.2: 

Upon entering the export data wizard, the user is prompted to select the 
fields of data to be exported. To select a field, highlight the field in the 
left-hand column and click the right-pointing arrow. To remove a field 
from the export list, highlight that desired field and click the left-pointing 
arrow. 
 
After selecting the fields to be exported the user is prompted to enter the 
date range of the data. NOTE: The export option is only available if the 
data save option for the database has been enabled (see the Formatting and 
Maintaining the Database section). After entering the range of data the 
user is asked to select an export file type and enter a file name. 

Figure 9.2: The Data Export Wizard  






